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1. Introduction
eProof fi les are self-contained PDF documents for viewing on-screen and for printing. They contain all appropriate formatting 
and fonts to ensure correct rendering on-screen and when printing hardcopy. DJS sends eProofs that can be viewed, annotat-
ed, and printed using the free version of Acrobat Reader 7 (or greater). These eProofs are “enabled” with commenting rights, 
therefore they can be modifi ed by using special markup tools in Acrobat Reader that are not normally available unless using 
the Standard or Professional version.
The screen images in this document were captured on a PC running Adobe Acrobat Reader version 8.1.0. Though some of 
the images may differ in appearance from your platform/version, basic functionality remains similar. At the time of this writing, 
Acrobat Reader v9.1 is freely available and can be downloaded from: http://get.adobe.com/reader/

2. Comment & Markup toolbar functionality

A. Show the Comment & Markup toolbar
The Comment & Markup toolbar doesn’t appear by default. Do one of 

 the following:
  • Select View > Toolbars > Comment & Markup.
  • Select Tools > Comment & Markup > Show Comment
    & Markup Toolbar.
  • Click the Review & Comment button in the Task toolbar, and choose
     Show Comment & Markup Toolbar.
 To add or remove tools for this toolbar, right-click the toolbar and select the tool. 
 Or, select Tools > Customize Toolbars.

B. Select a commenting or markup tool
 Do one of the following: 
  • Select a tool from the Comment & Markup toolbar.
  • Select Tools > Comment & Markup > [tool].
 Note: After an initial comment is made, the tool changes back to the Select tool 
 so that the comment can be moved, resized, or edited. (The Pencil, Highlight 
 Text, and Line tools stay selected.)

C. Keep a commenting tool selected
 Multiple comments can be added without reselecting the tool.
 Select the tool to use (but don’t use it yet). 
  • Select View > Toolbars > Properties Bar. 
  • Select Keep Tool Selected. 

Annotating PDFs
ams_annotating_pdfs1.1; April 09, 2009; full release

Choose Tools > Customize Toolbars to remove
unnecessary items from the toolbar

(see Section 7 for suggested toolbar layout)

Ch T l C t i T lb t

A. Sticky Note tool; B. Text Edits tool; C. Stamp tool; D. Highlight Text tool; E. Callout tool; F. Text Box tool; G. Various Object tools; H. Pencil tool

A B C D E F HG

3. The Properties bar
The Properties bar can be used to format text and select options for individual tools.
To view the Properties bar, do one of the following:
 • Choose View > Toolbars > Properties Bar.
 • Right-click the toolbar area; choose Properties Bar.
 • Select [Ctrl-E]
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4. Using the comment and markup tools
To insert, delete, or replace text, use the Text Edits tool. Select the Text Edits tool, then select the text with the cursor (or 
simply position it) and begin typing. A pop-up note will appear based upon the modifi cation (e.g., inserted text, replacement text, 
etc.). Use the Properties bar to format text in pop-up notes. A pop-up note can be minimized by selecting the     button inside it.

A

B

C

D

E

A. Attached fi le; B. Highlighted text; C. Crossed-out (strike-through) text; D. Inserted text; E. Replaced text

5. Inserting symbols or special characters
An ‘insert symbol’ feature is not available for annotations, and copying/pasting symbols or non-keyboard characters from Mi-
crosoft Word does not always work. Use angle brackets < > to indicate these special characters (e.g., <alpha>, <beta>).
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7. Summary of main functions
Insert text - Use Text Edits tool (position cursor and begin typing)
Replace text - Use Text Edits tool (select text and begin typing)
Delete text - Use Text Edits tool (select text and press delete key)
Highlight text - Use Highlight Text tool (select text)
Attach a fi le - Use the Attach a File with Comment tool (select tool, position 
                      cursor and click mouse, select fi le)

Suggested toolbar layout

Use the Comments list to review all changes

8. Reviewing changes
To review all changes, do the following: 
  • Select the Show button on the Comment & Markup toolbar.
  • Select Show Comments List.
   Note: Selecting a correction in the list will highlight the corresponding item in the document, and vice versa.

6. Editing near watermarks and hyperlinked text
eProof documents often contain watermarks and/or hyperlinked text. Selecting characters near these items can be diffi cult us-
ing the mouse alone. To edit an eProof which contains text in these areas, do the following: 
  • Without selecting the watermark or hyperlink, place the cursor near the area for editing.
  • Use the arrow keys to move the cursor beside the text to be edited.
  • Hold down the shift key while simultaneously using arrow keys to select the block of text, if necessary.
  • Insert, replace, or delete text, as needed.
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ABSTRACTAU1

New parameterizations for the spectral dissipation of wind-generated waves are proposed. The rates of

dissipation have no predetermined spectral shapes and are functions of the wave spectrum and wind speed

and direction, in a way consistent with observations of wave breaking and swell dissipation properties.

Namely, the swell dissipation is nonlinear and proportional to the swell steepness, and dissipation due to wave

breaking is nonzero only when a nondimensional spectrum exceeds the threshold at which waves are observed

to start breaking. An additional source of short-wave dissipation is introduced to represent the dissipation of

short waves due to longer breaking waves. A reduction of the wind-wave generation of short waves is meant to

account for the momentum flux absorbed by longer waves. These parameterizations are combined and

calibrated with the discrete interaction approximation for the nonlinear interactions. Parameters are adjusted

to reproduce observed shapes of directional wave spectra, and the variability of spectral moments with wind

speed and wave height. The wave energy balance is verified in a wide range of conditions and scales, from the

global ocean to coastal settings. Wave height, peak and mean periods, and spectral data are validated using in

situ and remote sensing data. Some systematic defects are still present, but, overall, the parameterizations

probably yield the most accurate estimates of wave parameters to date. Perspectives for further improvement

are also given.

1. Introduction

a. On phase-averaged models

Spectral wave modeling has been performed for the

last 50 years, using the wave energy balance equation

(Gelci et al. 1957). This model is based on a spectral

decomposition of the surface elevation variance across

wavenumbers k and directions u. The spectra density F

evolves in five dimensions that are the two spectral di-

mensions k and u, the two physical dimensions of the

ocean surface (usually longitude and latitude), and time t:

dF

dt
5 S

atm
1 S

nl
1 S

oc
1 S

bt
, (1)

where the Lagrangian derivative is the rate of change of

the spectral density following a wave packet at its group

speed in both physical and spectral spaces. In particular,

this spectral advection includes changes in direction due

to the earth’s sphericity, as well as refraction over varying

topography (e.g., Munk and Traylor 1947; Magne et al.

2007) and currents, and changes in wavelength or period

in similar conditions (Barber 1949).

The spectral source functions on the right-hand side of

Eq. (1) are grouped into their atmospheric (Satm), non-

linear scattering (Snl), oceanic (Soc), and bottom (Sbt)

sources. This grouping, like any other, is largely arbitrary.

For example, waves that break are nonlinear. Thus, the
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effects of breaking waves, which are contained in Soc,

is intrinsically related to the nonlinear evolution term

contained in Snl. Yet, compared to the usual separation

of deep-water evolution by wind input, nonlinear inter-

actions, and dissipation (e.g., WAMDI Group 1988), this

grou[ing has the benefit of identifying where the energy

and momentum are going to or coming from, which is

a necessary feature when ocean waves are used to drive

or are coupled with atmospheric or oceanic circulation

models (e.g., Janssen et al. 2004; Ardhuin et al. 2008b).

Here, Satm, which gives the flux of energy from the

atmospheric nonwave motion to the wave motion, is the

sum of a wave generation term Sin and a wind-generation

term Sout (often referred to as negative wind input, i.e.,

a wind output). The nonlinear scattering term Snl repre-

sents all processes that lead to an exchange of wave en-

ergy between the different spectral components. In deep

and intermediate water depth, this is dominated by cubic

interactions between quadruplets of wave trains, while

quadratic nonlinearities play an important role in shal-

low water (e.g., WISE Group 2007). The ocean source

Soc may accommodate wave–current interactions1 and

interactions of surface and internal waves. The oceanic

source term Soc is restricted to wave breaking and wave–

turbulence interactions.

The basic principle underlying Eq. (1) is that waves

essentially propagate as a superposition of almost linear

wave groups that evolve on longer time scales as a result

of weak-in-the-mean processes (e.g., Komen et al. 1994).

Recent reviews have questioned the possibility of fur-

ther improving numerical wave models without chang-

ing this basic principle (Cavaleri 2006). Although this

may be true in the long term, we demonstrate here that it

is possible to improve our model results significantly by

including more physical features in the source term pa-

rameterizations. The main advance that we propose is the

adjustment of a dissipation function without any pre-

scribed spectral shape, based on our empirical knowledge

of the breaking of random waves (Banner et al. 2000;

Babanin et al. 2001) and the dissipation of swells over

long distances (Ardhuin et al. 2009a). The present for-

mulations are still semiempirical, in the sense that they

are not based on a detailed physical model of dissipation

processes, but they demonstrate that progress is possible.

This effort opens the way for physical parameteriza-

tions (e.g., Filipot et al. 2010) that will eventually provide

new applications for wave models, such as the estimation

of statistical parameters for breaking waves, including

whitecap coverage and foam thickness. Other efforts,

though less empirical in nature, are also under way to ar-

rive at better parameterizations (e.g., Banner and Morison

2006; Babanin et al. 2007; Tsagareli 2008), but they have

yet to produce a practical alternative for wave forecasting

and hindcasting.

b. Shortcomings of existing parameterizations

Until the work of van der Westhuysen et al. (2007), none

of the wave dissipation parameterizations presented in

the literature had a quantitative relationship with observed

features of wave dissipation but rather they were adjusted

to close the wave energy balance. Komen et al. (1984) have

produced a family of parameterizations loosely justified by

the ‘‘random pulse’’ theory of Hasselmann (1974). In deep

water, parameterizations take a generic form:

S
oc

(k, u) 5 C
ds

g0.5k4.5
r H4

s d
1

k

k
r

1 d
2

k

k
r

� �2
" #

F(k, u), (2)

in which Cds is a negative constant, F(k, u) is the spectral

density, and H
s

5 4
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiÐ Ð

E(k, u) dk du
p

is the significant

wave height. The energy-weighted mean wavenumber

kr is defined from the entire spectrum as follows:

k
r
5

16

H2
s

ð f max

0

ð2p

0

krE(k, u) dk du

" #1/r

, (3)

where r is a real constant. Usual choices are r 5 20.5

(WAMDI Group 1988) or r 5 0.5 (Komen et al. 1984;

Bidlot et al. 2005).

These parameterizations are still widely used in spite

of inconsistencies in the underlying theory. Indeed, if

whitecaps do act as random pressure pulses, their aver-

age work on the underlying waves only occurs because

of a phase correlation between the vertical orbital ve-

locity field and the moving whitecap position, which

travels with the breaking wave. In reality the horizontal

shear is likely to be the dominant mechanism (Longuet-

Higgins and Turner 1974), but the question of correla-

tion remains the same. For any given whitecap, such a

correlation cannot exist for all spectral wave compo-

nents: a whitecap that travels with one wave leads to the

dissipation of spectral wave components that propagate

in similar directions, with comparable phase velocities.

However, whitecaps moving in one direction will give

(on average) a zero correlation for waves propagating in

the opposite direction because the position of the crests

of these opposing waves are completely random with

respect to the whitecap position. As a result, not all wave

components are dissipated by a given whitecap (others

should even be generated), and the dissipation function

cannot take the spectral form (2).

1 In the presence of variable current, the source of energy for the

wave field is the work of the radiation stresses. It is not explicit

when the energy balance is written as an action balance (e.g., Komen

et al. 1994).
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A strict interpretation of the pressure pulse model gives

a zero dissipation for swells in the open ocean because the

swell wave phases are uncorrelated to those of the shorter

breaking waves. There is only a negligible dissipation due

to short-wave modulations by swells and preferential

breaking on the swell crests (Phillips 1963; Hasselmann

1971; Ardhuin and Jenkins 2005). Still, the dissipation

functions given by Eq. (2) are applied to the entire spec-

trum, including swells, without any physical justification.

In spite of its successful use for the estimation of the

significant wave height Hs and peak period Tp, these fixed-

shape parameterizations, from Komen et al. (1984) up

to Bidlot et al. (2007a), have built-in defects that limit

the accuracy of the mode results. Most conspicuous is the

spurious amplification of wind sea growth in the presence

of swell (e.g., van Vledder and Hurdle 2002), which is

contrary to all of the observations (Dobson et al. 1989;

Violante-Carvalho et al. 2004; Ardhuin et al. 2007). As-

sociated with that defect also comes an underestimation

of the energy level in the inertial range, making these

wave models ill-suited for remote sensing studies, as will

be exposed below.

Also, these parameterizations typically give a decreasing

dissipation of swell with increasing swell steepness, con-

trary to all of the observations from Darbyshire (1958) to

Ardhuin et al. (2009b). This effect is easily revealed by

taking a sea state composed of a swell of energy E1 and

mean wavenumber k1 and a windsea of energy E2 and

mean wavenumber k2, with k2 . k1. The overall mean

wavenumber is

k
r
5[(kr

1E
1
1 kr

2E
2
)/(E

1
1 E

2
)]1/r. (4)

At low frequency (i.e., small wavenumbers) the dissi-

pation for a given value of k is given by the first term,

proportional to kr
3.5(E1 1 E2). Now, if we keep k1, k2 an

E2 constant and only increase the swell energy E1, the

relative change in dissipation is, according to (2), pro-

portional to x 5 3.5[(k1/kr)
r 2 1]/r 1 2. For r 5 0.5, as

used by Bidlot et al. (2005, hereinafter BAJ), x is neg-

ative (i.e., the dissipation decreases with increasing swell

energy) for k1/kr , 0.51. For equal energy in sea and

swell, this occurs when k1/k2 , 0.3, which is generally the

case with sea and swell in the ocean. This erroneous de-

crease of swell dissipation with increasing swell steepness

is reduced when the model frequency range is limited to

a maximum frequency of 0.4 Hz, in which case the lowest

winds (less than 5 m s21) are unable to produce a realistic

wind sea level, hence limiting the value of kr to relatively

small values.

An alternative and widely used formulation has been

proposed by Tolman and Chalikov (1996), and some of

its features are worth noting. We refer to this param-

eterization as TC, including the later adjustments by

Tolman (2002b). It combines two distinct dissipation

formulations for high and low frequencies, with a tran-

sition at 2 times the wind sea peak frequency. Janssen

et al. (1994) had already introduced the use of two terms,

k and k2 in Eq. (2), to represent the different effects

in the high- and low-frequency parts of the spectrum.

However, both terms are still multiplied by the same

factor, Cdsg
0.5kr

4.5Hs
4d. In TC, these two dissipation

terms are completely distinct, the low-frequency part

being a linear function of the spectral density and pro-

portional to wind friction velocity, u
*
; the high-frequency

part is also linear and proportional to u
*
2 . In this for-

mulation the frequency dependence of the two terms is

also prescribed. Tolman and Chalikov (1996) further

included swell attenuation by the wind, based on nu-

merical simulations of the airflow above waves (Chalikov

and Belevich 1993), here noted Sout. At relatively short

fetches, the Sin and Soc terms in TC are typically a factor

of 2–3 times smaller than those of Janssen et al. (1994).

This small magnitude of the source terms was found to

produce important biases in wave growth and wave

directions at short fetch (Ardhuin et al. 2007). Another

successful set of parameterizations, for high winds con-

ditions, is the combination by Makin and Stam (2003), but

it does not produce accurate results in moderate sea states

(Lefèvre et al. 2004). Polnikov and Inocentini (2008) have

also proposed new source term formulations, but their

results appear to generally be less accurate than those

with the model presented here, in particular for mean

periods.

Considering the observed strong wave height gradi-

ents in rapidly varying currents, Phillips (1984) proposed

a dissipation rate proportional to the nondimensional

spectrum, also termed the saturation spectrum. Banner

et al. (2002) indeed found a correlation of the direction-

integrated saturation B with the breaking probability of

dominant waves. In particular, they found that breaking

occurs when B exceeds a threshold Br. Alves and Banner

(2003) proposed to define the dissipation Soc by B/Br

to some power, multiplied by a Komen-type dissipation

term. Although this approach avoided the investigation

of the dissipation of nonbreaking waves, it imported all

of the above-mentioned defects of that parameteriza-

tion. Further, their value for Br, which was much higher

than suggested by the observations, tends to disconnect

the parameterization from the observed effects (Babanin

and van der Westhuysen 2008).

The use of a saturation parameter was taken up again

by van der Westhuysen et al. (2007, hereafter WZB).

They followed Banner et al. (2002) and integrated the

saturation spectrum over directions:
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B(k) 5

ð2p

0

k3F(k, u9) du9. (5)

From this, the WZB source function was defined as

S
oc,WZB

(k, u) 5 C
ds,WZB

ffiffiffiffiffiffi
gk

p B(k)

B
r

� �p/2

F(k, u), (6)

where Cds,WZB is a negative constant, Br is a constant

saturation threshold, and p is a coefficient that varies

both with the wind friction velocity u
*

and the degree

of saturation B(k)/Br with, in particular, p ’ 0 for

B(k) , 0.8Br. For nonbreaking waves, when p ’ 0, the

dissipation is too large by at least one order of magni-

tude, making the parameterization unfit for oceanic-

scale applications, with wave heights in the Atlantic

underpredicted by about 50% (Ardhuin and Le Boyer

2006). Van der Westhuysen (2007) eventually replaced

this dissipation of nonbreaking waves with the Komen-

type form proposed by the WAMDI Group (1988).

Further, the increase in p with the inverse wave age,

u
*
/C, tends to increase Soc at high frequency, and was

needed to obtain a balance with the Satm term in Eq. (1).

This indicates that, in addition to the value of the satu-

ration Br, other factors may be important, such as the

directionality of the waves (Banner et al. 2002). Other

observations clearly show that the breaking rate of high-

frequency waves is much higher for a given value of B,

probably due to the cumulative effects by which the

longer waves are modifying the dissipation of shorter

waves.

Banner et al. (1989) and Melville et al. (2002) have

shown that breaking waves suppress the short waves on

the surface. Young and Babanin (2006) arrived at the

same conclusion from the examination of pre- and post-

breaking wave spectra, and proposed a parameterization

for Soc that included a new ‘‘cumulative term’’ to repre-

sent this effect. Yet, their estimate was derived for very

strong wind-forcing conditions only. Their interpretation

of the differences in parts of a wave record with break-

ing and nonbreaking waves implies an underestimation

of the dissipation rates because the breaking waves have

already lost some energy when they are observed and

the nonbreaking waves are not going to break right after

they have been observed. Also, since the spectra are

different, nonlinear interactions must be different, even

on this relatively small time scale (e.g., Young and van

Vledder 1993, Fig. 5), and the differences in spectra may

not be the result of dissipation alone.

Finally, the recent measurement of swell dissipation

by Ardhuin et al. (2009a) has revealed that the dissipa-

tion of nonbreaking waves is essentially a function of the

wave steepness, and a very important process for ocean

basins larger than 1000 km. Because of the differences

in coastal and larger-scale sea states (e.g., Long and

Resio 2007), verifying the source function parameteri-

zations at all scales is paramount, in order to provide

a robust and comprehensive parameterization of the

wave dissipation.

c. A new set of parameterizations

It is thus time to combine the existing knowledge on

the dissipation of breaking and nonbreaking waves to

assemble a parameterization for the dissipation of

waves. Our objective is to provide a robust parameter-

ization that improves on existing wave models. For this

we will use the parameterization by BAJ as a benchmark

because it was shown to provide the best forecasts on

global scales (Bidlot et al. 2007b) before the advent of

the parameterizations presented here. BAJ is also fairly

close to the widely used Wave Action Model (WAM)

‘‘cycle 4’’ parameterization employed by Janssen and

others (Komen et al. 1994).

We will first present a general form of the dissipation

terms based on observed wave dissipation features. The

degrees of freedom in the parameterization are then

used to adjust the model results. A comprehensive val-

idation of wave parameters is then presented using field

experiments and a 1-yr hindcast of waves at the global

and regional scales, in which all existing wave mea-

surements are considered, with significant wave heights

ranging from 0 to 17 m. The model is further validated

with independent data at regional and global scales.

Model hindcasts and forecasts at global and regional

scales are available online (http://tinyurl.com/yetsofy),

covering at least the years 2002–10.

Tests and verification in the presence of currents, and

using a more realistic parameterization of wave–wave

interactions will be presented in future publication AU2s.

These may also include some replacement of the arbi-

trary choices made here.

2. Parameterizations

In this section we present the results of the integration

of the energy balance. Because numerical choices can

have important effects (e.g., Tolman 1992; Hargreaves

and Annan 2000), a few details should be given. All

calculations are performed within the WAVEWATCH

III modeling framework (Tolman 2008, 2009; hereinaf-

ter WWATCH), using the third-order spatial and spec-

tral advection scheme, and including modifications of

the source terms described here. The source terms are

integrated with the fully implicit scheme of Hargreaves

and Annan (2000), combined with the adaptation time

step and limiter method of Tolman (2002a), in which a
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minimum time step of 10 s is used, so that the limiter on

wind-wave growth is almost never activated. The di-

agnostic tail, proportional to f 25, is only imposed at a

cutoff frequency fc set to

f
c
5 f

FM
f

m
. (7)

Here, we take fFM 5 10 and define the mean frequency

as fm51/Tm0,1. Hence, fc is generally above the maxi-

mum model frequency that we fixed at 0.72 Hz, and the

high-frequency tail is left to evolve freely. Some com-

parison tests are also performed with other parameter-

izations using a lower value of fc, typically set at 2.5fm

(Bidlot et al. 2007a). In such calculations, although the

net source term may be nonzero at frequencies above fc,

there is no spectral evolution due to the imposed tail.

a. Nonlinear wave–wave interactions

All the results discussed and presented in this section

are obtained with the discrete interaction approxima-

tion (DIA) of Hasselmann et al. (1985). The coupling

coefficient that gives the magnitude of the interactions

is Cnl. Based on comparisons with exact calculations,

Komen et al. (1984) adjusted the value of Cnl to 2.78 3 107,

which is the value used by Bidlot et al. (2005). Here, this

constant will be modified slightly. The DIA parame-

terization is well known for its shortcomings (Banner

and Young 1994), and the adjustment of other parame-

ters probably compensates for some of these errors. This

matter will be fully discussed in a future publication.

b. Swell dissipation

Observations of swell dissipation are consistent with

the effects of friction at the air–sea interface (Ardhuin

et al. 2009a), resulting in a flux of momentum from the

wave field to the wind (Harris 1966). We thus write the

swell dissipation as a negative contribution Sout, which is

added to Sin to make the wind-wave source term Satm.

Using the method of Collard et al. (2009), a systematic

analysis of swell observations by Ardhuin et al. (2009a)

showed that the swell dissipation is nonlinear, which is

possibly related to a laminar-to-turbulent transition of

the oscillatory boundary layer over swells. Defining the

boundary Reynolds number Re 5 4uorbaorb/na, where

uorb and aorb are the significant surface orbital velocity

and displacement amplitudes, and na is the air viscosity,

we take, for Re less than a critical value Rec,

S
out

(k, u) 5�C
dsv

r
a

r
w

(2k
ffiffiffiffiffiffiffiffi
2ns
p

)F(k, u), (8)

where the constant Cdsv is equal to 1 in Dore (1978)’s

laminar theory and the radian frequency s is related to k

via the dispersion relation.

When the boundary layer is expected to be turbulent,

for Re $ Rec, we take

S
out

(k, u) 5�
r

a

r
w

(16 f
e
s2u

orb
/g)F(k, u). (9)

A few tests have indicated that a threshold Rec 5 (2 3

105 m)/Hs provides reasonable results, although it may

also be a function of the wind speed, and we have no ex-

planation for the dependence on Hs. A constant threshold

close to 2 3 105 provides similar—but less accurate—

results. Here, we shall use Cdsv 5 1.2.

The parameterization of the turbulent boundary layer

is a bit more problematic and, in the absence of direct

measurements in the boundary layer, leaves room for

speculations. Assuming a constant fe in (9), Ardhuin

et al. (2009b) found that swell observations are consis-

tent with 0.004 , fe , 0.013. From the analogy with an

oscillatory boundary layer over a fixed bottom (Jensen

et al. 1989), these values correspond to a surface with

a very small roughness. Because we also expect the wind

to influence fe, we include the adjustable effects of wind

speed on the roughness, and an explicit correction of fe

in the form of a Taylor expansion to first order in u
*
/uorb:

f
e
5 s

1
f

e,GM
1 [js

3
j1 s

2
cos(u� u

u
)]

u*
u

orb

� �
, (10)

where fe,GM is the friction factor given by Grant and

Madsen’s (1979) theory for rough oscillatory boundary

layers without a mean flow. Adequate swell dissipation

is obtained with constant values of fe in the range 0.004–

0.007, but these do not necessarily produce the best re-

sults when comparing wave heights to observations. Based

on the simple idea that most of the air–sea momentum

flux is supported by the pressure–slope correlations that

give rise to the wave field (Donelan 1998; Peirson and

Banner 2003), we have set the surface roughness seen by

the oscillatory flow z90 to a small fraction of that seen by

the mean flow z0:

z9
0

5 r
z0

z
0
. (11)

Here, rz0 is here set to 0.04. As a result, typical values of

aorb/z90 are as large as 2 3 105, with fe,GM of the order of

0.003.

The coefficients s2 and s3 of the O(u
*
/uorb) correction

have been adjusted to 20.018 and 0.015, respectively,

the former negative value giving a stronger dissipation

for swells opposed to winds, when cos(u 2 uu) , 0. This

gives a range of values of fe consistent with the obser-

vations, and reasonable hindcasts of swell decay (Fig. F11),

with a small underestimation of dissipation for steep
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swells. Because an increase of s1 from 0.8 to 1.1 produces

negative biases on Hs of the order of 30% at all oceanic

buoys, the magnitude of the swell dissipation cannot be

much larger is than chosen here.

Further validation of the swell dissipation is provided

by the global-scale hindcasts in section 4.

c. Wave breaking

Observations show that waves break when the orbital

velocity at their crest, Uc, comes close to the phase

speed, C, with a ratio Uc/C . 0.8 for random waves

(Tulin and Landrini 2001; Stansell and MacFarlane

2002; Wu and Nepf 2002). It is nevertheless difficult to

parameterize the breaking of random waves, since the

only available wave information here are the spectral

densities F(k, u). These densities can be related to the

orbital velocity variance in a narrow frequency band.

This question is addressed in detail by Filipot et al. (2010).

Yet, a proper threshold has to be defined for this quantity,

and the spectral rate of energy loss associated with

breaking has to be defined. Also, breaking is intricately

related to the complex nonlinear evolution of the waves

(e.g., Banner and Peirson 2007).

These difficulties will be ignored here. We shall pa-

rameterize the spectral dissipation rate directly from the

wave spectrum, in a way similar to WZB. Essentially, we

distinguish between spontaneous and induced breaking,

the latter being caused by large-scale breakers over-

taking shorter waves, resulting in their dissipation. For

the spontaneous breaking we parameterize the dissipa-

tion rate directly from the spectrum, without the inter-

mediate step of estimating a breaking probability.

We started from the simplest possible dissipation term

formulated in terms of the direction-integrated spectral

saturation B(k) given by Eq. (5), with a realistic threshold

B0r 5 1.2 3 1023 corresponding to the onset of wave

breaking (Babanin and Young 2005). This saturation

parameter corresponds exactly to the a parameter de-

fined by Phillips (1958). The value B0 5 8 3 1023, given

by Phillips, corresponds to a self-similar sea state in which

waves of all scales have the same shape, limited by the

breaking limit.

This view of the sea state, however, ignores com-

pletely wave directionality. Early tests of parameteri-

zations based on this definition of B indicated that the

spectra were too narrow (Ardhuin and Le Boyer 2006).

This effect could be due to many errors. Because Banner

et al. (2002) introduced a directional width in their sat-

uration to explain some of the variability in the observed

breaking probabilities, we similarly modify the defini-

tion of B. Expecting also to have different dissipation

rates in different directions, we define a saturation B9

that would correspond, in deep water, to a normalized

velocity variance projected in one direction (in the case

sB 5 2), with a further restriction of the integration of

directions controlled by Du:

B9(k, u) 5

ðu1D
u

u�D
u

k3coss
B (u� u9)F(k, u9)

C
g

2p
du9. (12)

Here, we shall always use Du 5 808. In our model, a sea

state with two systems with the same energy but of op-

posite direction will thus produce less dissipation than

a sea state with all the energy radiated in the same

direction.

We finally define our dissipation term as the sum of

the saturation-based term of Ardhuin et al. (2008a) and

a cumulative breaking term Sbk,cu:

FIG. 1. Comparison of modeled swell significant heights, fol-

lowing the propagation of the two swells shown by Ardhuin et al.

(2009AU14 ) with peak periods of 15 s and (top) high or (bottom) low

dissipation rates. Known biases in the level 2 data have been cor-

rected following Collard et al. (2009).
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S
oc

(k, u) 5 s
Csat

ds

B2
r

d
d

max[B(k)� B
r
, 0]2

1 (1� d
d
) max[B9(k, u)� B

r
, 0]2

8<
:

9=
;F(k, u) 1 S

bk,cu
(k, u) 1 S

turb
(k, u), (13)

where

B(k) 5 max B9(k, u), u 2 [0, 2p[f g. (14)

TAU3 he combination of an isotropic part (the term that

multiplies dd) and a direction-dependent part (the term

with 1 2 dd) was intended to allow some control of the

directional spread in the resulting spectra. This aspect is

illustrated in FF2 ig. 2 with a hindcast of the 3 November 1999

case during the Shoaling Waves Experiment (SHOWEX;

Ardhuin et al. 2007). Clearly, the isotropic saturation

in the TEST442 dissipation (with the original threshold

Br 5 0.0012) produces very narrow spectra, even though

it is known that the DIA parameterization for nonlinear

interactions tends to broaden the spectra. The same

pattern of behavior is obtained with the isotropic pa-

rameterization by van der Westhuysen et al. (2007), as

demonstrated by Ardhuin and Le Boyer (2006). Further,

using an isotropic dissipation at all frequencies yields an

energy spectrum that decays faster toward high frequen-

cies than the observed spectrum (Fig. 2a). On the con-

trary, a fully directional dissipation term (TEST443 with

dd 5 0) gives a better fit for all of the parameters. With

sB 5 2, we reduce Br to 0.0009, a threshold for the onset

of breaking that is consistent with the observations of

Banner et al. (2000) and Banner et al. (2002), as discussed

by Babanin and van der Westhuysen (2008). The overall

dissipation term in TEST443 is anisotropic due to the

cumulative effect, but this does not significantly alter the

underestimation of the directional spread.

The dissipation constant Csat
ds was adjusted to 2.2 3 1024

in order to give acceptable time-limited wave growth

and good directional fetch-limited growth as described

by Ardhuin et al. (2007). As noted in this previous work,

similar growth patterns in wave energy with fetch are

possible with almost any magnitude of the wind input,

but a reasonable mean direction in slanting fetch con-

ditions selects the range of possible levels of input. Here,

the mean directions at the observed peak frequency are

still biased by about 258 toward the alongshore direction

with the parameterizations proposed here (Fig. 2b), which

is still less that the 508 obtained with the weaker Tolman

and Chalikov (1996) source terms (Ardhuin et al. 2007,

Fig. 11). A relatively better fit is obtained with the BAJ

parameterization. This is likely due to either the stron-

ger wind input or the weaker dissipation at the peak. It is

likely that both features of the BAJ parameterization

are more realistic than what we propose here.

The equilibrium sea state, achieved by most models

for long durations with steady wind and infinite fetch,

and often compared with the Pierson and Moskowitz

(1964) spectrum, is largely controlled by the balance be-

tween the nonlinear flux of energy to low frequencies and

the wind output term, as discussed below. F F3igure 3 shows

the fetch-limited growth in wave energy of the various

parameterizations. We repeat here the sensitivity test to

the presence of swell, which has already been displayed

in Ardhuin et al. (2007). Whereas the 1-m swell causes

an unrealistic doubling of the wind sea energy at short

fetch in the BAJ parameterization, the new parame-

terizations, just like the one by van der Westhuysen et al.

(2007), are by design insensitive to swell (not shown).

The dissipation Sturb due to wave–turbulence inter-

actions is expected to be much weaker (Ardhuin and

Jenkins 2006) and will be neglected here.

Finally, following the analysis by Filipot et al. (2010),

the threshold Br is corrected for shallow water, so that

B9/Br in different water depths corresponds to the same

ratio of the root-mean-square orbital velocity and phase

speed. For periodic and irrotational waves, the orbital

velocity increases much more rapidly than the wave height

as it approaches the breaking limit. Further, due to non-

linear distortions in the wave profile in shallow water, the

height can be twice as large as the height of linear waves

with the same energy. To express a relevant threshold

from the elevation variance, we consider the slope

kHlin(kD) of an hypothetical linear wave that has the

same energy as the wave of maximum height. In deep

water,2 kHlin(‘) ’ 0.77, and for other water depths we

thus correct Br by a factor [kHlin(kD)/kHlin(‘)]2. Using

streamfunction theory (Dalrymple 1974), a polynomial

fit as a function of Y 5 tanh(kD) gives

B9
r
5 B

r
Y(M

4
Y3 1 M

3
Y2 1 M

2
Y 1 M

1
), (15)

such that B9r 5 Br in deep water. The fitted constants are

M4 5 1.3286, M3 5 22.5709, M2 5 1.9995, and M1 5

0.2428. Although this behavior is consistent with the var-

iation of the depth-limited breaking parameter g derived

empirically by Ruessink et al. (2003), the resulting dissi-

pation rate is not yet expected to produce realistic results

2 This value of the maximum equivalent linear height, Hlin 5

2
ffiffiffiffiffiffi
2E
p

, with E being the elevation variance, is smaller than the usual

value kH 5 0.88 due to the correction for the nonlinear wave

profile for which H .
ffiffiffiffiffiffi
2E
p

.
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for surf zones because no effort was made to verify this

aspect. This is the topic of ongoing work, which is outside

of the scope of the present paper.

The cumulative breaking term Sbk,cu represents the

smoothing of the surface by big breakers with celerity C9

that wipe out smaller waves of phase speed C. Due to

uncertainties in the estimation of this effect in the obser-

vations of Young and Babanin (2006), we use the theo-

retical model of Ardhuin et al.(2009b). Briefly, the relative

velocity of the crests is the norm of the vector difference,

Dc 5 jC 2 C9j, and the dissipation rate of short wave is

simply the rate of passage of the large breaker over short

waves, that is, the integral of DCL(C) dC, where L(C) dC

is the length of breaking crests per unit surface that have

velocity components between Cx and Cx 1 dCx, and

between Cy and Cy 1 dCy (Phillips 1985). Because there

is no consensus on the form of L (Gemmrich et al. 2008),

we prefer to link L to the breaking probabilities. Based

on Banner et al. [(2000, Fig. 6); bT 5 22(« 2 0.055)2], and

taking their saturation parameter � to be of the order

of 1.6
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
B9(k, u)

p
, the breaking probability of dominant

waves is approximately

P 5 56.8[max(
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
B9(k, u)

p
�

ffiffiffiffiffiffi
B9

r

q
, 0)]2. (16)

However, because they used a zero-crossing analysis for

a given wave scale, there are many times when waves are

not counted since the record is dominated by another

scale: in their analysis there is only one wave at any given

time. This tends to overestimate the breaking proba-

bility by a factor of 1.5–2 (Manasseh et al. 2006), com-

pared to the present approach in which we consider that

several waves (of different scales) may be present at the

same place and time. We shall thus correct for this effect,

by simply dividing P by 2.

With this approach we define the spectral density of

the crest length (breaking or not) per unit surface l(k)

such that
Ð

l(k) dkx dky is the total length of all crests per

unit surface, with a crest being defined as a local maximum

of the elevation in one horizontal direction. In the wave-

number vector spectral space we take

FIG. 2. Wave spectra on 3 Nov 1999 at buoy X3 (fetch, 39 km;

wind speed U10 5 9.4 m s21), averaged over the time window

1200–1700 EST, from observations and model runs, with different

model parameterizations (symbols): BAJ stands for Bidlot et al.

(2005). The (a) energy, (b) mean direction, and (c) directional spread

are shown. This figure is analogous to Figs. 10 and 11 in Ardhuin et al.

(2007), and the model forcing and setting are identical. It was further

verified that halving the resolution from 1 km to 500 m does not

affect the results. All parameterizations settings are listed in Tables

A1 and A2. Input parameters for TEST443 are identical to those for

TEST441, and TEST442 differs from TEST441 only in its isotropic

direct breaking term, given by sB 5 0, Du 5 1808, and Br 5 0.0012.

FIG. 3. Fetch-limited growth of the windsea energy as a function

of fetch on 3 Nov 1999, averaged over the time window 1200–1700

EST, from observations and model runs, with different model pa-

rameterizations (symbols): BAJ stands for Bidlot et al. (2005). This

figure is analogous to Fig. 8 in Ardhuin et al. (2007), the model

forcing and settings are identical. All parameters for BAJ, TEST441,

and TEST443 are listed in Tables A1 and A2. The input parameters

for TEST443 are identical to those for TEST441, and TEST442

differs from TEST441 only in its isotropic direct breaking term,

given by sB 5 0, Du 5 1808, and Br 5 0.0012.
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l(k) 5 1/(2p2k), (17)

which is equivalent to a constant in wavenumber-direction

space l(k, u) 5 1/(2p2). This number was obtained by

considering an ocean surface full of unidirectional waves,

with one crest for each wavelength 2p/k for each spectral

interval Dk 5 k; for example, one crest corresponding to

spectral components in the range 0.5–1.5 k. This potential

number of crests is doubled by the directionality of the

sea state. These two assumptions have not been verified

and thus the resulting value of l(k) is merely an adjustable

order of magnitude.

Thus, the spectral density of the breaking crest length

per unit surface is L(k) 5 l(k)P(k). Assuming that any

breaking wave instantly dissipates all the energy of all of

the waves with frequencies higher by a factor rcu or more,

then the cumulative dissipation rate is simply given by the

rate at which these shorter waves are taken over by larger

breaking waves times the spectral density; namely,

S
bk,cu

(k, u) 5 C
cu

F(k, u)

ð
f 9,rcu f

D
C

L(k9) dk9, (18)

where rcu defines the maximum ratio of the frequencies

of long waves that will wipe out the short waves.

We now obtain L by extrapolating Eq. (16) to higher

frequencies. With 56.8/(4p2) 5 1.44, it gives the source

term

S
bk,cu

(k, u) 5�1.44C
cu

F(k, u)

ðrcu f

0

ð2p

0

max(
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
B(k9, u9)

p
�

ffiffiffiffiffiffi
B

r

q
, 0)2

D
C

du9 dk9,

We shall take rcu 5 0.5, and Ccu is a tuning coefficient

expected to be a negative number of order 1, which also

corrects for errors in the estimation of l.

This generic form of the source terms produces mark-

edly different balances for both mature and fully devel-

oped seas.

For mature seas, without cumulative effect, FF4 ig. 4

shows that a balance is possible that gives roughly the

same energy level and wind input term up of to 0.4 Hz as

the BAJ parameterization. However, the balance in the

tail results in the energy level decreasing slower than f 24

as the dissipation is too weak compared to the input, and

thus the nonlinear energy flux is reversed, pumping en-

ergy from the tail to lower frequencies.

The introduction of a strong cumulative term

(TEST437) allows a balance at roughly the same energy

level. However, with the present formulation this will

lead to a dissipation that is too strong at high frequency

for higher winds. The introduction of the sheltering

effect via the parameter su (details in section 2d) is

designed to reach a balance with a weaker cumulative

effect.

The most important qualitative feature is the lack of

a regular predefined shape for the normalized dissipa-

tion term, Soc(k, u)/E(k, u). Whereas the shape given by

dk 1 (1 2 d)k2 is clearly visible in BAJ (with extremely

high dissipation rates if one considers high frequencies),

and the low- to high-frequency dissipation transition at

2fp is evident in TC, the shapes of the new dissipation

rates are completely dictated by the local spectral satu-

ration level. This leads to a relatively narrow peak of

dissipation right above the spectral peak, where the

saturation is strongest.

This feature helps to produce realistic spectral shapes

near the peak, with a steeper low-frequency side and

a more gentle slope on the high-frequency side, contrary

to the backward-facing spectra produced by BAJ and

TC. However, this localized strong relative dissipation,

Soc(k, u)/F(k, u), is hard to reconcile with the time and

spatial scales of breaking events, and is thus probably

exaggerated. Indeed, there should be no significant dif-

ference in the relative dissipation among the spectral

components that contribute to a breaking wave crest,

provided that they do not disperse significantly over the

breaker lifetime, which is less than a wave period. There

is no physical reason why a breaking event would take

much more energy, relatively speaking, from the spec-

tral band (1.1–1.2)fp than from (1.2–1.3)fp. The factor of

2 difference found here in the relative dissipation rates

thus appears to be unrealistic. This strong relative dis-

sipation at the peak (50% higher than in BAJ) is one

important factor that leads to slower growth of the wave

spectrum in TEST441 compared to BAJ. It is possible

that the localization of Soc at the peak compensates for

the broader spectrum produced by the DIA compared

to results with an exact nonlinear interaction calculation.

We now consider ‘‘fully developed’’ conditions, as il-

lustrated by F F5ig. 5. At low frequency, the nonlinear swell

damping term Sout (the negative part of Sin) cancels

about 30%–50% of the nonlinear energy flux, so that the

sea state grows only very slowly. As a result, ‘‘full de-

velopment’’ does not exist, but the resulting energy is still

compatible with the observations of mature sea states

(Alves et al. 2003). In contrast, the linear swell damping

adjusted by Tolman (2002b) is designed to produce rea-

sonable swell heights in the tropics, but it is much smaller
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than the nonlinear energy flux to low frequencies, even

with the reduced interaction coefficient proposed by

Tolman and Chalikov (1996). A nonlinear swell dissi-

pation appears to be necessary to obtain both a realistic

damping of observed swells and a satisfactory agree-

ment with mature wind waves. Nonlinearity also brings

within the same order of magnitude the decay scales

estimated for short (Högström et al. 2009) and very long

swells (Ardhuin et al. 2009b).

Both parameterizations are physically very different

from the parameterizations of the Komen et al. (1984)

family, including Bidlot et al. (2005). In these cases, the

FIG. 4. Academic test case over a uniform ocean with a uniform

10 m s21 wind starting from rest, after 8 h of integration, when

Cp/U10 ’ 1. Source term balances are given by the parameterization

BAJ, and the parameterizations proposed here with the successive

introduction of the cumulative breaking and the wind-sheltering

effects with the parameters Ccu and su. For BAJ, a diagnostic f 25

tail is applied above 2.5 3 the mean frequency. The source terms

are multiplied by the normalization function M( f ) 5 rwC/

[raE( f )sU10]. The TC stands for of Tolman and Chalikov (1996).

FIG. 5. As in Fig. 4, but after 48 h of integration and without

normalization of the source terms. Source term balances are given

by the parameterization BAJ, and the parameterizations proposed

here with the successive introduction of the cumulative breaking

and the wind-sheltering effects with the parameters Ccu and su.
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swell energy is lost to the ocean via whitecapping. Here,

we propose that this energy is lost to the atmosphere,

with an associated momentum flux that drives the wave-

driven wind observed in wave flumes (Harris 1966) and

for very weak winds at sea (Smedman et al. 2009).

In the inertial range, a reasonable balance of all the

source terms is obtained for Ccu 5 20.4 (Fig. 5). In this

case, the spectrum approaches an f 24 shape up to 0.4 Hz.

The behavior of the high-frequency tail is best seen when

displayed in nondimensional form, as is done in FF6 ig. 6.

Figure 6 shows the unrealistically high level of the tail

without cumulative effect nor modification of the wind

input, and the equally unrealistic low tail with the BAJ

parameterization, especially when the tail is left to evolve

freely. With the TEST441 parameterization (Ccu 5 0.4

and su 5 1), the spectral level at 0.7 Hz (3 m wavelength)

may be 30% too high compared to other analyses by

Long and Resio (2007), but the resulting spectral mo-

ments m3 is still slightly underpredicted (Ardhuin et al.

2009b). Spectral levels for shorter waves (20 cm–2 m)

were estimated at a 5 1.8 3 1023 by Banner et al. (1989).

There is thus a strong need for more spectral measure-

ments in the range of wavelengths from 0.5 to 5 m, outside

of the range of buoy measurements.

Adding the cumulative effect can be a means of con-

trolling the tail level, but this degree of freedom is not

enough. Indeed, in strongly forced conditions the dom-

inant waves break frequently, and a high cumulative

effect, Ccu 5 21, reduces the energy level in the tail below

observed levels. This effect can be verified with mean

square slopes estimated from satellite altimeter mea-

surements (Fig. 8), or high moments of the frequency

spectrum derived from buoy data (not shown but similar).

A more accurate shape of the spectrum tail may be

obtained with a lower Ccu or a higher rcu, so that domi-

nant breaking waves will only wipe out much smaller

waves. Instead, and because the wind to wave momentum

flux was too high in high winds, we chose to introduce one

more degree of freedom, allowing a reduction of the wind

input at high frequency.

d. Wind input

The wind input parameterization is thus adapted from

Janssen (1991; see also Chalikov 1991) and the following

adjustments performed by Bidlot et al. (2005, 2007a).

The full wind input source term reads

S
in

(k, u) 5
r

a

r
w

b
max

k2
eZZ4 u*

C

	 
2
3 max[cos(u� u

u
), 0]p

sF(k, u), (19)

where bmax is a nondimensional growth parameter (con-

stant) and k is von Kármán’s constant. In the present

implementation the air–water density ratio is constant.

The power of the cosine is taken constant with p 5 2. We

define the effective wave age Z 5 log(m), where m is given

by Janssen (1991; see also Chalikov 1991), and corrected

for intermediate water depths, so that

Z 5 log(kz
1
) 1 k/[cos(u� u

u
)(u*/C 1 z

a
)], (20)

where z1 is a roughness length modified by the wave-

supported stress tw and za is a wave age tuning param-

eter. We define z1 implicitly AU4by

U
10

5
u?

k
log

z
u

z
1

� �
, (21)

z
0
5 min a

0

t

g
, z

0,max

� �
, and (22)

z
1
5

z
0ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi

1� t
w

/t
p , (23)

where zu is the height at which the wind speed is speci-

fied, usually 10 m. The maximum value of z0 was added

to reduce possible unrealistic wind stresses at high winds

that are otherwise given by the standard parameteriza-

tion. For example, z0,max 5 0.0015 is equivalent to set-

ting a maximum wind drag coefficient of 2.5 3 1023. For

the TEST441 parameterization, we have adjusted za 5

0.006 and bmax 5 1.52 (F F7ig. 7).

An important part of the parameterization is the cal-

culation of the wave-supported stress tw, which includes

the resolved part of the spectrum, as well as the growth

of an assumed f 25 diagnostic tail beyond the highest

frequency. This parameterization is highly sensitive to the

high-frequency part of the spectrum since a high energy

level there will lead to a larger value of z1 and u
*
, which

gives a positive feedback and reinforces the energy levels.

FIG. 6. Values of the spectral saturation B0 for the cases presented

in Fig. 5.
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To allow a balance with the saturation-based dissi-

pation, the wind input at high frequency is reduced by

modifying the friction velocity u
*
. This correction also

reduces the drag coefficient at high winds. In particular,

the wind input is reduced for high frequencies and high

winds, loosely following Chen and Belcher (2000). This

is performed by replacing u
*

in Eq. (19) with a wave-

number-dependent u9
*
(k) defined by

(u9*)2
5 u2

*( cosu
u
, sinu

u
)

� s
u

�� �� ðk

0

ð2p

0

S
in

(k9, u)

C
( cosu, sinu) dk9 du, (24)

where the sheltering coefficient jsuj ; 1 can be used to

tune the wind stresses for high winds, which would be

largely overestimated for su 5 0. For su . 0, this shel-

tering is also applied within the diagnostic tail, which

requires the estimation of a three-dimensional lookup

table for the high-frequency stress. The shape of the new

wind input is illustrated in Fig. 7 for fully developed seas.

Clearly, for relatively young waves the energy levels at

the spectral peak are lower with su 5 1 (TEST441) than

in other runs; this is largely due to a reduced feedback of

the wave age on the wind stress via the tw/t term in Eq.

(23). The reduction of za from 0.011 to 0.006 strongly

reduces the input for frequencies in the range 0.15–

0.2 Hz, which is probably overestimated in BAJ when

average (20%) levels of gustiness are considered: now

the wind input goes to zero for f 5 0.13, which corre-

sponds to C/U10 5 0.83, whereas it is still significant at

that wave age in the BAJ parameterization. As a result

the much lower input level needs a readjustment, per-

formed here by increasing bmax to 1.52. Yet, this high

value of bmax produces very high wind stress values and

thus a very strong high-frequency input. Adding the

sheltering term su 5 1 allows a decent balance at high

frequency. Finally, the addition of the air–sea friction

term that gives swell dissipation produces a significant

reduction of the input to the wind sea at f 5 0.25 Hz. It is

questionable whether this mechanism also applies in the

presence of the critical layer for those waves. This matter

clearly requires more theoretical and experimental

investigation.

3. Consequences of the source term shape

We have already illustrated the effects of various pa-

rameters on spectral shapes in academic time-limited

and more realistic fetch-limited conditions. We now look

at real sea states observed in the World Ocean. Although

wave spectra are difficult to compare to the few available

observations, we have investigated the systematic varia-

tion of spectral moments:

m
n
( f

c
) 5

ð f
c

0

ð2p

0

f nF( f , u) du df , (25)

with n 5 2, 3, and 4, and cutoff frequencies in the range

0.2–0.4 Hz. The spectral density F( f, u) is estimated as

2pF(k, u)/Cg, using linear wave theory. Such moments

are relevant to a variety of applications. Ardhuin et al.

(2009b) investigated the third moment, which is pro-

portional to the surface Stokes drift in deep water, and

found that buoy data are very well represented by a sim-

ple function of U10, Hs, and fc, which typically explains

95% of the variance of m3.

This relationship is well reproduced in hindcasts using

Ccu 5 20.4 and su 5 1, while the BAJ source terms give

almost a constant value of m3 when Hs varies and U10 is

fixed (Ardhuin et al. 2009b).

Here, we consider the fourth moment m4, which, for

linear waves, is proportional to a surface mean square

slope filtered at the frequency fc. For modeled values

a constant 0.011 is added to account for the short waves

that contribute to the satellite signal and that are not re-

solved in the model. This saturated high-frequency tail,

independent of wind speed, is consistent with the ob-

servations of Banner et al. (1989) and Vandemark et al.

(2004).

Fig F8ure 8 shows that for any given wind speed mssC

increases with the wave height (Gourrion et al. 2002),

whereas this is not the case for m4 in the BAJ parame-

terization, or, for very high winds, when Ccu is too strong.

In the case of BAJ, this is due to the (k/kr)
2 part in the

FIG. 7. Incremental adjustments to the wind–wave interaction

source term Satm, going from the BAJ form to the one used in

TEST441. From one curve to the next, only one parameter is

changed. Different Satm are given for the same wave spectrum,

previously obtained by running the model from a calm sea for 8 h

with the BAJ parameterization and a wind speed of 10 m s21.
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dissipation term [Eq. (2)], which plays a role similar to

the cumulative term in our formulation. For Ccu 5 21

and su 5 0, the cumulative effect gets too strong for wind

speeds over 10 m s21, in which case m4 starts to decrease

with increasing wave height, whereas for high winds and

low (i.e., young) waves, the high-frequency tail is too

high and the mean square slope gets to be as large as 6%,

which is unrealistic. For su 5 0 the high-frequency tail

responds too much to the wind, hence our use of su 5 1 in

the TEST441 combination. The presence of a cumulative

dissipation term allows for a different balance in the

spectral regions above the peak, where an equilibrium

range with a spectrum proportional to f 24 develops (Long

and Resio 2007), and in the high-frequency tail were the

spectrum decays like f 25 or possibly a little faster. The

spectral level in the range 0.2–0.4 Hz was carefully com-

pared against buoy data and was found to be realistic.

These interpretations rely on the assumption that the

model results are really wavenumber spectrum E(u) con-

verted to frequency densities using linear wave theory,

FIG. 8. Variation of the surface mean square slope estimated as either (bottom left) 0.64/s0 using the C-band

altimeter on board Jason-1 after the correction of a 1.2 dB bias in the Jason data; or by integration of modeled spectra

from 0 to 0.72 Hz, with either (bottom right) the Ccu 5 20.4 and su 5 1 parameterization (TEST441) or the (top right)

parameterization by BAJAU15 . The original 1-Hz data from Jason is subsampled at 0.5 Hz and averaged over 10 s (i.e.,

58 km along the satellite track). The same averaging is applied to the wave model result, giving the total of 393 382

observations reported here, for the first half-year of 2007.

Fig(s). 8 live 4/C
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which is expected to be closer to the frequency spectra

obtained from Lagrangian buoy measurements, and the

wavenumber spectrum of nonlinear waves (Janssen 2009).

This matter is left for further studies, together with a de-

tailed interpretation of the altimeter radar cross sections.

Although it covers much less data, the analysis of m4

obtained from buoy heave spectra produces results sim-

ilar to Fig. 8.

4. Verification

To provide simplified measures of the difference be-

tween the model time series Xmod and the observations

Xobs, we use the following definitions for the normalized

root-mean-square error (NRMSE),

NRMSE(X) 5

ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
�(X

obs
�X

mod
)2

�X2
obs

vuuut ; (26)

the normalized bias,

NB(X) 5

ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
�X

obs
�X

mod

�X
obs

vuuut ; and (27)

Pearson’s linear correlation coefficient,

r(X) 5
�(X

obs
�X

obs
)(X

mod
�X

mod
)ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi

�(X
obs
�X

obs
)

2
(X

mod
�X

mod
)2

q , (28)

where the overbar denotes the arithmetic average.

The normalization of the errors allows a quantitative

comparison between widely different sea state regimes.

Because previous studies have often used (nonnormalized)

RMSEs, we also provide RMSE values. In addition to the

coastal fetch-limited case of SHOWEX, presented above,

the parameterizations are calibrated on at the global scale

and validated in two other cases.

a. Global-scale results

We present here results for the entire year 2007, using

a stand-alone 0.58 resolution grid, covering the globe

from 808 south to 808 north. The model has actually been

adjusted to perform well over this dataset, but the very

large number of observations (over 2 million altimeter

collocation points) makes the model robust and an in-

dependent validation on 2008 gives identical results. The

interested reader may also look at the monthly reports

for the Service Hydrographique et Océanographique de

la Marine (SHOM) model (e.g., Bidlot 2008), generated

as part of the model verification project of the Intergov-

ernmental Oceanographic Commission–World Meteoro-

logical Organization (IOC–WMO) Joint Commission on

Oceanography and marine Meteorology (JCOMM), in

which the TEST441 parameterization (Ccu 5 20.4 and

su 5 1) is used, except for the Mediterranean where, the

TEST405 has been preferred for its superior perfor-

mance for younger seas. These SHOM models are run in

a combination of two-way nested grids (Tolman 2007).

The monthly JCOMM reports include both analyses and

forecasts, and many SHOM forecasts from December

2008 to June 2009 have been affected by wind file transfer

problems.

Comparing the model results for Hs to well-calibrated

altimeter-derived measurements (Queffeulou and Croizé-

Fillon 2008) provides a good method of verification for

the model performance in a number of different wave

climates. F F9igure 9 shows that, as expected, the impor-

tant positive bias in the swell-dominated regions when

using the BAJ parameterization has been largely re-

moved. This is essentially the signature of the specific

swell dissipation that is parameterized in Sout. The

largest bias pattern now appears in the Southern Ocean,

reaching 30 cm in the southern Atlantic. Although this

bias is small compared to the local averaged wave

height, it is rather odd when the model errors are plotted

as a function of wave height in F F10ig. 10. Why would the

model overestimate the Southern Ocean waves but un-

derestimate the very large waves?

The structure of the large bias, also seen in model

results of BAJ, is reminiscent of the observed pattern in

iceberg distribution noticed by Tournadre et al. (2008).

Assuming a full blocking of wave energy by icebergs

larger than 1 km in diameter is enough to cancel most of

the bias. These observed iceberg distributions are enough

to give a cross section for incoming waves of the order of

1%–10% for a 250-km propagation length. Taking ice-

bergs into account could actually reverse the sign of the

bias. This matter will be investigated elsewhere.

Also noticeable is a significant negative bias in the

equatorial South Pacific, amplified from the same bias

obtained with the BAJ parameterization. It is possible

that the masking of subgrid islands (Tolman 2003) in-

troduces a bias by neglecting shoreline reflections. This

model defect could be exacerbated in this region by the

very large ratio of shoreline length to sea area. This will

also require further investigation. Finally, the negative

biases for Hs along midlatitude east coasts are reduced

but still persist. It is well known that these areas are also

characterized by strong boundary currents (such as the

Gulf Stream, Kuroshio, and Agulhas current) with warm

waters that are generally conducive to wave amplifica-

tion and faster wind-wave growth (e.g., Vandemark et al.
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2001). Neither effect is included in the present calculation

because the accuracy of both modeled surface currents

and air–sea stability parameterizations are likely to be

insufficient (Collard et al. 2008; Ardhuin et al. 2007).

The reduction of systematic biases clearly contributes

to the reduction of RMSEs, as is evident in the equa-

torial eastern Pacific (FF11 ig. 11). However, the new pa-

rameterization also brings a considerable reduction to

the scatter, with reduced errors even where biases are

minimal, such as the trade winds area south of Hawaii,

where the NRMSE for Hs can be as low as 5%. When

areas within 400 km from continents are excluded, be-

cause the global model resolution may be inadequate,

significant errors (.12.5%, in yellow to red) remain in

the northern Indian Ocean, on the North American and

Asian east coasts, and in the southern Atlantic. The

parameterizations TEST405, TEST437, and TEST441

produce smaller errors on average than BAJ. It is likely

that the model benefits from the absence of swell in-

fluences on wind seas: swell in BAJ typically leads to

a reduced dissipation and stronger wind wave growth.

As models are adjusted to average sea state conditions,

this adjustment leads to reduced wind sea growth along

east coasts, where there is generally less swell.

For the highest waves, the model scatter is smallest,

with some important biases for some parameterizations.

Although the altimeter estimates are not expected to be

valid for Hs larger than about 12 m, due to the low

backscatter and a waveform that is too short to properly

estimate Hs, this good model performance contradicts

some claims (e.g., Cavaleri 2009) that models may be

more inaccurate for severe weather.

Although much more sparse than the altimeter data,

the in situ measurements collected and exchanged as

part as the JCOMM wave model verification are very

useful for constraining other aspects of the sea state.

This is illustrated here with mean periods Tm02 for data

provided by the U.K. and French meteorological ser-

vices, and peak periods Tp for all other sources. It is

worth noting that the errors in Hs for in situ platforms

are comparable to the errors found for altimeter data.

With the BAJ parameterizations, the largest errors in

the model results are the 1.2–1.8-s biases in peak periods

along the U.S. west coast (F F12ig. 12), and the under-

estimation of peak periods along the U.S. east coast.

However, peak and mean periods off the European

coasts are generally very well predicted. When using the

TEST441 parameterization, the explicit swell dissipa-

tion reduces the bias over periods along the U.S. west

coast, but the problem is not completely solved, with

residual biases of 0.2–0.4 s. This is consistent with the

validation using satellite synthetic aperture radar (SAR)

FIG. 9. The bias (cm) for the year 2007. The global 0.5 WWATCH model is compared to

altimeters aboard the Jason-1, the Environmental Satellite (Envisat), and Geosat Follow-On

(GFO) satellite following the method of Rascle et al. (2008). (top) The result with the BAJ

parameterization, and (bottom) the result with the Ccu 5 20.4 and su 5 1 (TEST441)

parameterization.

Fig(s). 9 live 4/C
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data (Fig. 1), which showed a tendency to underpredict

steep swells near the storms and overpredict them in the

far field. A simple increase in the swell dissipation was

tested but it tended to deteriorate the results of other

parameters; this trend is possibly associated with an

underestimation of wave heights in the center of severe

storms using TEST441. Along European coasts, despite

a stronger bias, the errors in Tm02 are particularly re-

duced. Again, this reduction of the model scatter can be

largely attributed to the decoupling of swell from

windsea growth.

The general performance of the parameterizations is

synthesized in T T1able 1. It is interesting to note that the

parameterization TEST405, which uses a diagnostic tail

for 2.5 times the mean frequency, gives good results in

terms of the scatter and bias even for parameters related

to short waves (m3, m4). This use of a diagnostic tail is

thus a reasonable pragmatic alternative to the more

costly explicit resolution of shorter waves, which re-

quires a smaller adaptive time step, and more complex

parameterizations. The diagnostic tail generally mimics

the effects of both the cumulative and sheltering effects.

Yet, the parameterization TEST441 demonstrates that

it is possible to obtain slightly better results with a free

tail. The normalized biases indicated for the mean

square slopes are only relative because of the approxi-

mate calibration of the radar cross section. They show

that the BAJ parameterization (Bidlot et al. 2005), and

to a lesser extent the use of a f 25 tail, produce energy

levels that are relatively lower at high frequency.

b. Lake Michigan

At the global scale, the sea state is never very young,

and it is desirable to also verify the robustness of the

parameterization in conditions that are more represen-

tative of the coastal ocean. We thus follow the analysis

of the performance of wave models in Rogers and Wang

(2007), hereinafter RW2007, and give results for Lake

Michigan, which is representative of relatively young

waves. The model was applied with the BAJ, TC,

TEST437, and TEST441 parameterizations over the same

time frame as was investigated by RW2007: 1 September–

14 November 2002. The model is run with 4-km resolution

and with other settings and forcing fields similar to those

defined by RW2007 (e.g., 108 directional resolution and

wind field derived from in situ observations).

Using the directional validation method proposed by

these authors, the TC parameterization underestimates

the directional spread su by 1.28–1.68 in the range (0.8–

2.0)fp, and more at higher frequencies. The underes-

timation with BAJ is about half, and the TEST441 and

TEST437 simulations overpredict the directional spread

by about 2.38–5.98 in the range (0.8–2.0)fp, and less so for

FIG. 10. Wave model errors as a function of observed Hs: (top to

bottom) bias, scatter index (SI), NRMSE, and number of obser-

vations. The model output at 3-h intervals is compared to that from

Jason-1, Envisat, and GFO following the method of Rascle et al.

(2008). Namely, the altimeter 1-Hz Ku-band estimates of Hs are

averaged over 18. This provides 2 044 545 observations.
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higher frequencies. It thus appears that the broadening

introduced to fit the SHOWEX 1999 observations is not

optimal for other situations. A similar positive bias in

the directional spread is also found in global hindcasts.

Further results are presented in TT2 able 2 and FF13 ig. 13.

The top panel in Fig. 13 shows a comparison between

the summed values of collocated model and observed

spectral densities for the duration of the simulation.

This presentation provides a frequency distribution of

the bias of the various models, while also indicating the

relative contribution of each frequency to the wave cli-

mate for this region and time period. The bottom panel

in Fig. 13 shows the correlation coefficient r for the

equivalent significant wave heights computed for mul-

tiple frequency bands. This is presented in terms of f/fp

(bin width 5 0.1), with fp being calculated as the stabi-

lized ‘‘synthetic peak frequency’’ of the corresponding

buoy spectrum, as defined in RW2007.

The most noticeable outcome of these comparisons is the

relatively poor performance of the TC parameterizations.

Taken in context with other TC results presented herein

and a prior undocumented application of the model in

the Great Lakes with model wind fields, this suggests that

these parameterizations have some undesirable depen-

dence on scale, with the parameters adjusted by Tolman

(2002b) being most optimal for ocean-scale applications

and nonoptimal for small-scale applications.

The Kiehl–Hack–Hurrell (KHH) physics scheme per-

forms well. This is consistent with prior published appli-

cations with the Simulating Waves Nearshore (SWAN)

model, (Rogers et al. 2003) and RW2007. However, as

noted by those authors, the KHH physics have an

advantage in this simple wave climate, and should

not be expected to perform well in mixed sea swell

conditions.

The BAJ, TEST437 and TEST441 models also perform

well here. Taken together with the global comparisons

above, we observe no apparent dependency of model skill

on the scale of the application with these three physics.

In the bias comparison (Fig. 13, top), the BAJ model is

FIG. 11. Normalized RMSE (%) for the significant wave height over the year 2007. The

global 0.58 resolution WWATCH model is compared to altimeters aboard the Jason-1, Envisat,

and GFO following the method of Rascle et al. (2008). (top) The result with the BAJ parame-

terization, and (bottom) the result with the Ccu 5 20.4 and su 5 1 (TEST441) parameterization.
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nearly identical to the KHH model. Similarly, the two

new models are nearly identical. In terms of Hs (Table 2),

the TEST441 and TEST437 yield minor underestima-

tions, but give slightly more accurate results compared

to observations than BAJ or KHH.

It thus appears that for such young seas, the directional

spreading of the parameterization could be improved, but

the energy content of various frequency bands, and as

a result the mean period, are reproduced with less scatter

than with previous parameterizations.

c. Hurricane Ivan

Although the global hindcast does contain quite a few

extreme events, with significant wave heights up to 17 m,

these were obtained with a relatively coarse wave model

grid and wind forcing (0.58 resolution and 6-h time step)

FIG. 12. Statistics for the year 2007 based on the JCOMM verification database (Bidlot et al.

2007b). Shown are the (a),(d) bias and (b),(c) NRMSE for Tp or Tm02 at in situ locations using

(a),(b) the BAJ method or (c),(d) the proposed TEST441 (Tp is shown at all buoys except for

the U.K. and French buoys, for which Tm02 is shown). The different symbols are only used to

help distinguish the various colors and do not carry extra information.

Fig(s). 12 live 4/C
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that are insufficient to resolve small storms such as trop-

ical cyclones (Tolman and Alves 2005). Hurricane waves

do share many similarities with more usual sea states

(Young 2006), but the high winds and their rapid rotation

are particularly challenging for numerical wave models. It

is thus necessary to verify that the new source functions

perform adequately under extreme wind conditions. A

simulation of Hurricane Ivan (Gulf of Mexico, September

2004) is chosen for this purpose because it was extensively

measured (e.g., Wang et al. 2005) and hindcasted.

Winds for this simulation are based on 3-hourly grid-

ded surface wind analyses created by National Oceanic

and Atmospheric Administration’s (NOAA) Hurricane

Research Division (HRD). As an intermediate step, fields

are reprocessed at 30-min intervals, with the storm po-

sition updated at each interval (thus, semi-Lagrangian

interpolation). The wind speeds are reduced by factor of

1/1.11 to convert from the maximum sustained gust to an

hourly mean. The HRD winds do not cover the entire

computational domain. For areas falling outside the do-

main, the nearest National Data Buoy Center (NDBC)

wind observation is used. This produces some non-

physical spatial discontinuities in the wind field, but these

TABLE 1. The model accuracy for significant wave height mea-

sured wave parameters over the oceans in 2007. The mss data from

Jason-1 corresponds to January–July 2007 (393 382 collocated

points), while Hs statistics are obtained for the entire year and all

available satellites. These global averages are area weighted, and

the scatter index (SI) and NRMSE are the area-weighted averages

of the local SI and NRMSE. The Tp and Tm02 statistics are averages

of statistics computed for each buoy separately. For Tp, we used

WMO buoys 41002, 41010, 42001, 42002, 42003, 44004, 44008, 44011,

44137, 44138, 44139, 44141, 46001, 46004, 46035, 46066, 46184, 46002,

46005, 46036, 46059, 51001, 51002, 51003, and 51004; for Tm02, we

used 62029, 62081, 62163, and 64045; and for m3, we took the results

for buoy 46005 as given in Ardhuin et al.(2009a). Unless otherwise

specified by the number in parenthesis, the cutoff frequency is taken

to be 0.4 Hz, where C for C band. The normalized bias (NB) is de-

fined as the bias divided by the RMS observed value, while the SI is

defined as the RMS difference between the modeled and observed

values, after correction for the bias, normalized by the RMS observed

value, and r is Pearson’s correlation coefficient.

Test Test Test

BAJ 405 437 441

Hs

NB (%) 22.1 20.8 0.2 21.23

SI (%) 11.8 10.5 10.6 10.4

NRMSE (%) 13.0 11.5 11.6 11.3

m4 (C)

NB (%) 216.1 24.9 22.3 22.5

SI (%) 10.7 9.1 9.1 9.1

R 0.867 0.925 0.931 0.939

Tp

NRMSE (%) 24.1 19.0 19.4 18.2

Tm02

NRMSE (%) 7.6 6.9 6.6 6.7

m3

NB (%) 214.6 1.7 22.3 22.4

SI (%) 20.6 12.6 14.8 12.6

NRMSE (%) 25.3 13.1 13.1 12.8

R 0.934 0.971 0.961 0.973

TABLE 2. Model–data comparison at NDBC buoy 45007 (Lake

Michigan) for four frequency bands. Statistics are given for equiv-

alent significant wave heights in the bands 0.5fp , f , 0.8fp (band 1),

0.8fp , f , 1.2fp (band 2), 1.2fp , f , 2fp (band 3), and 2fp , f , 3fp

(band 4). The KHH n 5 2 run corresponds to the dissipation pa-

rameterization defined by Rogers et al. (2003) and based on Komen

et al. (1984) and applied in the WWATCH code. For the peak fre-

quency band, statistics are also given for the directional spread su.

Test Test KHH

BAJ TC 437 441 n 5 2

Hs band 1

SI (%) 76 71 77 82 76

Hs band 2

SI(%) 16 19 15 15 15

Hs band 3

SI (%) 18 26 17 17 19

Hs band 4

SI (%) 20 32 18 17 22

su band 2

SI (%) 22 24 30 30 25

Bias (8) 20.4 21.6 2.3 2.6 0.8

Hs bias (m) 20.03 20.11 20.02 20.02 0.04

R 0.95 0.94 0.96 0.96 0.96

SI (%) 19 25 18 18 19

Tm02

Bias (s) 0.02 20.39 20.05 20.05 0.01

R 0.89 0.87 0.90 0.90 0.90

SI (%) 10 14 9 9 10

FIG. 13. Model–data comparison at NDBC buoy 45007 (Lake

Michigan). (top) Comparison of the summed spectral density vs the

frequency for the duration of the simulation, and (bottom) the

correlation coefficients vs the normalized frequency (see text for

explanation).

Fig(s). 13 live 4/C

MONTH 2010 A R D H U I N E T A L . 19

JOBNAME: JPO 00#0 2010 PAGE: 19 SESS: 8 OUTPUT: Thu Jun 24 02:27:51 2010 Total No. of Pages: 25
/ams/jpo/0/jpo4324

Jo
ur

na
l o

f P
hy

si
ca

l O
ce

an
og

ra
ph

y 
 (P

ro
of

 O
nl

y)



are smoothed in the wave model integration and, in any

event, only affect weaker wind seas far from the storm

center.

Bathymetry is taken from the Naval Research Labo-

ratory’s 29-resolution database (DBDB2) coarsened to

the computational grid resolution (0.18). The directional

resolution is 108, and the frequency range is limited to

0.0418–0.4117 Hz. The model was applied from 13 to 16

September 2004. Model results are illustrated in FF14 ig. 14.

The models were validated at all of the buoys in the Gulf

of Mexico. Results from buoy 42040, where the waves

where largest, are shown here.

Model runs with parameterizations BAJ, TEST437,

and TEST441 give very similar results: close to the ob-

servations, except for the highest waves (Hs . 13 m at

buoy 42040), where TEST437 and TEST441 give slightly

smaller values. Results with the TC parameterization

are generally lower in terms of Hs than are all of the

parameterizations that share a Janssen type of input. It

appears that the new source term perform similarly to

BAJ and is able to reproduce such young waves and

severe sea states.

Because the wind forcing enters the wave model through

a wind stress parameterized in a way that may not apply

to such conditions, it is worthwhile to reexamine some

choices made above. In particular the surface roughness

was allowed to exceed 0.002 in TEST441b, which resulted

in better estimates of Hs. Lifting this constraint shows

that, for these very high winds, the wind-sheltering effect

plays a similar role in limiting the roughness to z0,max,

with the difference that it tends to narrow the wind input

spectrum (Fig. 7). This narrower wind input has a limited

effect of the wind stress and Hs, but is has a noticeable

effect on the spectral shape. This is illustrated by the

low-frequency energy that appears to be strongly over-

estimated before the peak of the storm for TEST441b.

In general the new parameterizations provide results

that are as reasonable as those of previous parameteri-

zations, given the uncertainty of the wind forcing.

5. Conclusions

A set of parameterizations for the dissipation source

terms of the wave energy balance equation have been

proposed, based on known properties of swell dissipa-

tion and wave breaking statistics. This dissipation in-

cludes an explicit nonlinear swell dissipation and a wave

breaking parameterization that contains a cumulative

term, representing the dissipation of short waves by lon-

ger breakers, and different dissipation rates for different

directions. These dissipation parameterizations have

been combined with a modified form of the wind input

proposed by Janssen (1991), in which the questionable

gustiness parameter za has been reduced, and the gen-

eral shape of the wind input has been significantly mod-

ified. The resulting source term balance is thus markedly

different from the previous proposed forms, with a near

balance for very old seas between the air–sea friction

term that dissipates swell and the nonlinear energy flux

to low frequencies. Also, the wind input is concentrated

in a narrower range of frequencies.

For younger seas the wind input is weaker than that

given by Janssen (1991) but stronger than that given by

Tolman and Chalikov (1996). However, the dissipation

at the peak is generally stronger because it is essentially

based on a local steepness and these dominant waves are

the steepest in the sea state. As a result, the short fetch

growth is relatively weaker than that with the source

term combination proposed by Bidlot et al. (2007a) (BAJ).

The choice of parameters tested here tends to produce

broader directional spectra than those observed in Lake

Michigan and global hindcasts, and slanting fetch di-

rections that are too oblique relative to the wind (Fig. 2).

In this respect the new source terms are intermediate

between BAJ and TC.

Another defect comes from the definition of the sat-

uration level used to define the breaking-induced dissi-

pation. Here, as in the work by van der Westhuysen et al.

(2007), the saturation is local in frequency space, whereas

wave breaking is naturally expected to have a relatively

broad impact due to its localization in space and time

(Hasselmann 1974). This is expected to produce an

overestimation of the energy just below the peak, and an

underestimation at the peak of the saturation spectrum.

FIG. 14. Time series of model and buoy (top) significant wave

height and (bottom) partial wave height (for f , 0.06 Hz), during

the passage of Hurricane Ivan, at buoy 42040. The 10-m discus

buoy was capsized by waves and could not record waves after

16 September.

Fig(s). 14 live 4/C
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These effects likely contribute to the persistent over-

estimation of low-frequency energy in the model.

In spite of these defects, the new parameterization

produces robust results and clearly outperforms the

Bidlot et al. (2007a) parameterization in global hind-

casts, whether one considers dominant wave parameters,

Hs, Tm02, and Tp or parameters sensitive to the high-

frequency content, such as the surface Stokes Uss drift or

the mean square slope. At global scales, errors in Hs, Tp,

and Uss are—on average—reduced by 15%, 25%, and

50% relative to those obtained with the parameteriza-

tion by Bidlot et al. (2007a). Global and regional hind-

casts (North and Irish Seas, English Channel, Tuamotu,

Lesser Antilles, and more), from 2002 to 2010 at least,

are available for further analysis online (http://tinyurl.

com/yetsofy).

Another important aspect of this study was the vali-

dation at regional to global scales. We note that the TC

paper does include verification with steady-state, fetch-

limited growth curves. Though such verification is a use-

ful step, the outcome of the Lake Michigan hindcast

suggests that such verification gives no indication of the

model’s skill in real subregional-scale applications. One

of the parameterizations proposed here (TEST441) also

gives slightly poorer performance for young seas, which

is not obvious in the case of Lake Michigan, but was

revealed by hindcasts of Mediterranean waves (not shown).

Because our intention was only to demonstrate the

capability of new dissipation parameterizations and the

resulting source term balances, we have not fully adjusted

the 18 parameters that define the deep water parame-

terizations, compared to the roughly 9 used by Bidlot

et al. (2007a). The results presented here are thus pre-

liminary in terms of model performance, which is why

the parameterizations are still given temporary names

like TEST441. As illustrated by the Hurricane Ivan hind-

cast, some parameters, such as z0,max, are probably un-

necessary; in that particular case, the removal of z0,max

improved the results, but for global-scale results it had no

impact at all (not shown).

Because five of the extra parameters define the air–sea

friction term that produces swell dissipation, and two

define the cumulative breaking term, it is feasible to de-

fine a systematic adjustment procedure that should in-

crease the model accuracy by separately adjusting the

swell, wind sea peak, and high-frequency properties. In

particular, the directional distribution may be improved

by making the dissipation term more isotropic (i.e.,

taking dd . 0.3) or modifying the definition of the sat-

uration parameter B9 in Eq. (12). In a forthcoming paper

we shall further investigate the responses of the wave

field to varying currents, from global scales to regional

tidal currents. From that research, we expect that wave

steepening will produce much more dissipation due to

breaking, as envisaged by Phillips (1984).

Obviously, it is well known that the discrete interaction

approximation used here to compute the nonlinear inter-

actions is the source of large errors, and further calcula-

tions will be performed using a more accurate estimation

of these interactions in the future.
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TABLE A1. Wind–wave interaction parameters as implemented in version 3.14 of SHOM in the WWATCH code, and values used in the

tests presented here. In WWATCH, all parameters are accessible via the SIN3AU16 name list. All of these parameters are included in version

3.14 of WWATCH. Note that s0 is a switch that, if nonzero, activates the calculation of Sout.

Parameter Eq. Variable in WWATCH WAM cycle 4 BAJ TEST405 TEST437 TEST441

a0 (19) ALPHA0 0.01 0.0095 — — —

bmax (20) BETAMAX 1.2 1.2 1.55 1.52 —

za (20) ZALP 0.011 0.011 0.006 — —

z0, max (22) Z0MAX NA NA 0.002 — —

su (24) TAUWSHELTER 0.0 0.0 0.0 0.0 1.0

s0 SWELLFPAR 0 0 3 — —

s1 (10) SWELLF 0.0 0.0 0.8 — —

s2 (10) SWELLF2 0.0 0.0 20.018 — —

s3 (10) SWELLF3 0.0 0.0 0.015 — —

0.5RecHs SWELLF4 0.0 1 3 105 — — —

Cdsv (9) SWELLF5 0.0 0.0 1.2 — —

rz0 (11) Z0RAT 0.0 0.0 0.04 — —

zu (21) ZWND 10 10 10 10 10

p (19) SINTHP 2 2 2 2 2
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APPENDIX

Parameter Settings

The numerical values of all parameters that define the

source functions are listed in TTA1 able A1 for the wind–wave

interaction term Satm and TTA2 able A2 for the wave–ocean

interaction term Soc. We also recall that the nonlinear

coupling coefficient (variable NLPROP in WWATCH)

is set to 2.78 3 107 in all cases, except for the two pa-

rameterizations mostly frequently used here, with Cnl 5

2.5 3 107 in TEST437 and TEST441. Although the best

performance for most parameters is obtained with the

TEST441 settings, its underestimation of extreme sea

states may be a problem in some applications for which

TEST437 may be preferred. A full tuning of the model

has not been attempted yet and it is possible that simple

adjustments to bmax Ccu, rcu, and su may produce even

better results. Finally, these parameters have been mostly

adjusted for deep water conditions using European Centre

for Medium-Range Weather Forecasts (ECMWF) winds.

Using other sources of winds for large-scale applications

may require a retuning of the wind source function, which

can be performed by a readjustment of bmax.
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